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industry news

3ds Max 2008 Architectural Visualisation - 3DATS is pleased to announce 
the shipping of the only 3ds Max 2008 book dedicated to architectural visualiza-
tion: 3ds Max 2008 Architectural Visualization - Beginner to Intermediate. This 
480 page, full-color, hard-cover bound book takes you through the challenge of 
learning one of the most complex computer programs ever created, by way of easy-
to-follow tutorials and time tested production techniques. It specifically focuses on 
those parts of the program you need to know to be productive in the industry today. 
Book on 3ds Max 2008 Architectural Visualization - Intermediate to Advanced 
will release in March 2008 to grab.

Introduction to Lighting in XSI - Digital-Tutors, a SOFTIMAGE® Offi-
cial Training Partner and leading provider in video-based training, today announced 
the availability of ‘Introduction to Lighting in XSI’- the newest release in an ex-
panding library of interactive video-based training for emerging digital artists using 
SOFTIMAGE|XSI®, a complete 3D package for modeling, rendering and charac-
ter animation. ‘Introduction to Lighting in XSI’ provides over two hours of essential 
techniques for adding greater realism and a time-saving workflow to lighting within 
XSI—Ideal for beginning and intermediate artists seeking various lighting meth-
ods.

Computer Scientist Makes Splash With 
Academy Award For Fluid Simulation

The rushing floodwaters in Evan Almighty, the heaving 
seas of the latter two Pirates of the Caribbean movies 
and the dragon’s flaming breath in Harry Potter and the 
Goblet of Fire all featured computer-generated fluids 
in spectacular action. The science behind those splashy 
thrills will be recognized with an Academy Award for 
Ron Fedkiw, associate professor of computer science at 
Stanford, and two collaborators at the special effects firm 
Industrial Light and Magic (ILM). 

Computer graphics experts typically have used particles 
and complex blobs to represent water, but these can give 
rise to unrealistically lumpy or grainy surfaces. Alterna-
tively, they have used a technique called “the level set 
method” that gives a smooth surface representation, but 
some water is “under-resolved” and simply disappears 
when it breaks down into small volumes, as in a crashing 
wave.

Nvidia to Acquire Ageia Technologies

NVIDIA, the world leader in visual 
computing technologies and the in-
ventor of the GPU, announced that it 
has signed a definitive agreement to 
acquire AGEIA Technologies, Inc., 
the industry leader in gaming physics 
technology. AGEIA’s PhysX software is widely adopted 
with more than 140 PhysX-based games shipping or in 
development on Sony Playstation3, Microsoft XBOX 
360, Nintendo Wii and Gaming PCs. AGEIA physics 
software is pervasive with over 10,000 registered and ac-
tive users of the PhysX SDK. 

Now the question becomes how will this move by NVID-
IA affect the end products they bring to market and ulti-
mately how will it affect the consumer?  It’s probably safe 
to say  we likely won’t see the fruits of those efforts inside 
of the traditional 9 - 12 month development cycles seen 
in high-end semiconductors.
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Matthieu Roussel



interview

Q.  Hi could you tell us a bit about yourself and your background in CG and are 
you self taught or taken some training?

Hi, my name is Matthieu Roussel and I was born in 1964 in Marseille (south of 
France). I live in France near Toulouse. I’m married and father of 3 children. I stud-
ied and lived in Paris for 17 years. I was student in an art (school, ecole nationale 
superieure des arts decorative de Paris).

I start working as free-lance illustrator during the end of my study in 1991 and still 
free-lance from this date. I have two illustrator representatives, one in Paris (www.
virginie.fr) and one in North America (www.threeinabox.com)

Q.  So, you are a freelancer, please tell us what difficulties a freelancer have to face in getting the work?

The difficulty is to begin to work, calling art director and to show a book, go back home and waiting a phone call. You 
have to trust in yourself and to believe in your talent. For me it happens step by step, and I had the chance to meet good 
people at the good moment. If you are a little serious in your work, it should be easy.

The second thing must have enough work to live and find an agent. I was ready to work for ad agency, and finding an 
agent is the key to work in this field of activity. Jobs are very different, various, and the agent leave your mind free for 
creation in front of question of money.

AN INTERVIEW WITH 
Matthieu Roussel
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interview

Q.  What software program(s) do you use for your CG and why?

I start working with Photoshop in 1997, then with Strata 3d for 3d. I worked with this software for several years and 
change for Cinema 4d, because I needed more tools for modeling.

Cinema 4d is very powerful and very easy to learn, very stable on a Mac environment.
Render times are very fast, even on global illumination mode. I use a little poser 6 for realistic human models, and just 
start to learn Zbrush to complete Cinema 4d for organic modeling. I think Cinema 4d for the moment is my privileged 
software.

Q.   Do you do any preliminary drawings before you model, or do you just start and see what happens and how long 
on average would you spend on an image?

I always work like that. A good draw before starting modeling is the best way to success what you have in mind.

For two reasons:

-The client wants to have an idea of the future illustration he orders, and a good sketch gives him confident.

-with a good sketch, I lose less time when modeling, because I know very well what I want to do. I mean, 3d is so pow-
erful than you can lose yourself in the software.

AN INTERVIEW WITH 
Matthieu Roussel
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interview

Q.  Your work “Juicy Head” is totally different from your other works. Can you tell us in brief about the making of 
this image and what problems you have faced?

Yes you are right; this is a Canadian ad agency (DDBO) which wanted an illustration for own promotion.

The art director sent me by mail a sketch of the idea, and I start working very quickly. In a morning time I realize the 
head, the top part of the juicer and fixed the point of view. I made a speed render and send it to the art director

From this start the ad director made a photo of a guy in the good position and sends it to me back. The most difficult 
was made and I just made some changes and adjustments for the ugly white spots… this job wasn’t very difficult to 
do.

AN INTERVIEW WITH 
Matthieu Roussel
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Q.  How much you enjoy creating an image/illustration for the magazine? Any special thing required keeping in 
mind while doing this type of stuff?

I’m a curious person, so each new work is a challenge for me. Innovation is very motivating for me...I love to do differ-
ent things... The thing keeping in mind when I make an illustration, is to hear very attentively the need of the client, 
and the public for who I will make this illustration. By example for an adult magazine I have to make an adult style, 
even if my style is a toon style...I have to find a balance between my pleasure and the client need. If I respect that, it 
works most of the time.



Matthieu Roussel



interview

Q.  What other interests do you have that help influence your work and keep you motivated?

Looking computer graphics galleries on internet keep me motivated. Buying childbook and visiting museum...

Q.  Do you have a dream project that you would like to work on?

A 3d movie for cinema  of course!!!!, I dream to have enough talent to write the story, to create characters design 
and environment…to find a producer, which  will give me a complete studio full o f animators, and  
making a movie with  my own style.. A Dream!!

Q.  What’s the most useful thing you have learnt in 3d?

The most useful thing for me is to make things most simply possible. 
Less lightning as possible, less special effects... But it’s hard to resist
 when you have in your hand so many tools on a 3d software…

Q.  Are you working on any projects currently? If so, what are they?

I’m waiting a text from a French writer for a new child book... and will 
have this year to make it.  

On another way, I have some ad jobs, as 
packaging, and I have to work on a Louis XIV folder for a French magazine...

Q.  Anything you like to add? It is your chance now to state your opinion about 
anything.

I would like to visit India, this country is fascinating for me (my library is full 
of books about India) and I’m sure I will go there in the future, in this life or 
in another one.. ;)

                                                                                      Website:  www. mattroussel.com 
                                                                                      Email: matt@mattroussel.com

AN INTERVIEW WITH 
Matthieu Roussel
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advertisement
Project Dogwaffle Professional: 

Beyond Digital Painting

The Project Dogwaffle Leap-year Celebration & Special offer: 
Order any of PD Pro 3.5, PD Pro 4, an upgrade from PD 2.x to 3, an upgrade from PD Pro 3.x to 4, and the 

Tutorial Collection #1: Discovering Project Dogwaffle, and save 29% through February 29! 
Use this discount coupon: BGCF000ZA on the BMT store – Learn more: http://thebest3d.com/pdpro  

Using PD Pro 4.1 for post work & turning a single image into a looping animation

Original image, painted in PD Pro 
by Mark Hamilton: see 

http://thebest3d.com/dogwaffle/dotm 

Add a lightning storm
Add more drama with thick brush and animated 

shrubbery in the foreground

Turn it into a night scene, add volumetric light cones, 
a snow storm and light diffusion, and 

turn it into a looping animation. 

Click to view the complete tutorial – Dark Snow 

See the animation: Click Here See the animation: Click Here

See the animation – Click here

AN INTERVIEW WITH 
Matthieu Roussel

http://thebest3d.com/dogwaffle/dotm
http://thebest3d.com/pdpro/tutorials/darksnow
http://thebest3d.com/pdpro/tutorials/darksnow/MyAVI4.htm
http://thebest3d.com/pdpro/tutorials/darksnow/MyAVI5.htm
http://thebest3d.com/pdpro/tutorials/darksnow/MyAVI6.htm
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CGArena is proud to present  “Ancient Times”  3D Challenge,  15 Feb 2008 - 28 Apr 2008, sponsored 
by Pixologic, Craft Animations, iZ3d, N-Sided, Hyperfocal Design, ambientLight, Polyboost and 
Noesis Interactive.  Express your creative ideas in a new and interesting way.

Your Mission

Create a 3D image which justify the theme of Ancient Times, this can any city, culture, war, mystry or anything else 
which you can think of. This Challenge is a Work-In-Progress Challenge -- all contestants are required to post their 
work-in-progress images for community to critique/comment in order to qualify. 

How the Challenge will be Run
This challenge will be a WIP (Work in Progress) Challenge. Each challenger is required to submit Work In Progress 
(WIP) images, from the initial concept sketch to the final render. to the post production on regular intervals. The pur-
pose is that everyone can learn from each other, offer feedback and critiques.

1. Enter the Challenge by registering yourself on CGArena forum.
2. Submit your work in progress images in forum on a regular basis. otherwise will be disqualified.
3. Participate in the community by critiquing other challengers works in the respective threads.
4. You are allowed to use any software for the creation of artowork. No premade models are allowed to use.
5. Registration for the challenge will close on 30th Mar 2008, midnight 00:00 GMT.
6. Submit your final entry till 28th Apr 2008, midnight 00:00 GMT.
7. You are allowed to use any type of post- production in the final image to make artwork better and richer.
8. There will be 2 winners. Judges, sponsors, CGArena decision will be final .

challenge



        

Terms and Conditions
1.) Entrants agree to give permission to the sponsor to use all or any part of the artwork entered in this contest, (here-
inafter, the ‘Work’) in the Company’s demonstration tapes (reels), promotional materials (ads, PR, etc.), booth graphics 
and presentations for the promotional purposes.

2.) Entrants will retain all rights to the Work. In addition, the Company will not sell for profit any materials or demo 
reels containing images or animations submitted by the Entrant.

3.) The Company, in exchange for this release, will provide a credit for the Work within the material in which the Work 
is used.

Final Image Size 

- Your final image dimensions should be print resolution (300 DPI). Do not send in a low-resolution.
- A guideline is minimum 1200 pixels wide and/or 1024 high, JPG, 300 DPI.
- Send your final image in zip or rar format with your name, complete shipping address, email, telephone number in a 
text file on email address ancient@cgarena.com with subject “Ancient Times Entry”. 

First Winner - $7323 USD

Craft Animations Craft Director Tools - $5000 Craft Director Tools will give you professional –looking ani-
mations in minutes. No more scripts. No more wasted time. Speed Animation for Animators, Architects, Broadcasting, 
PreViz, VFX etc.  This package includes 24+ plug-ins.

22” iZ3d Monitor - $999 22” iZ3D is an advanced video monitor capable of displaying impressive into-screen and 
out-of-screen 3D images with passive polarized glasses. iZ3D is designed to replace standard two-dimensional moni-
tors while maintaining commercial image quality and display brightness.

Pixologic  Zbrush 3.1 - $595 ZBrush 3.1 gives you access to unparalleled power and control previously unknown 
in digital art creation software. Controls enable sculptors to create with a stylus and a tablet as intuitively as if they 
were using their hands on a block of clay. ZBrush further extends the creation experience, harnessing technology and 
providing artists with a multitude of creation-enhancing tools.

N-Sided - Quidam 2 Studio - $575 QUIDAM, the core application works as standalone software to create and 
export models automatically subdivided (i.e. smoothed). QUIDAM 2.0 Studio is aimed at all the advanced users, no-
tably to the professionals of real time 3D and video games.

Polyboost 4 - $154 -  PolyBoost is an extensive set of easy to use, but advanced tools for 3d artists working in 3ds 
max. The focus of the PolyBoost tools is at speeding up and streamlining workflow for the artist. PolyBoost offers a 
wide range of tools for creating various types of subobject selections as well as a set of modeling tools which will make 
many tasks in everyday modeling a lot easier.

mailto:ancient@cgarena.com
http://www.cgarena.com/ccount/click.php?id=156
http://www.cgarena.com/ccount/click.php?id=157
http://www.cgarena.com/ccount/click.php?id=155
http://www.n-sided.com
http://www.polyboost.com


        

Second Winner - $1164 USD

Hyperfocal Design - 10 HDRI Skies and Environments - $590 Each HDRI Environment can add in-
stant, super realistic lighting to 3D scenes, with accurate reflections and a dynamic background that reacts realistically.  
Each HDRI Sky can add instant, super realistic lighting to 3D scenes, with accurate reflections

N-Sided - Quidam 2  - $240 The days of spending hours creating characters from scratch, polygon by polygon, 
in overly complex programs are over! QUIDAM reinvents character modeling to make it natural, productive and to let 
you sign your own creations. QUIDAM, the core application works as standalone software to create and export models 
automatically subdivided (i.e. smoothed). 

Polyboost 4 - $154 -  PolyBoost is an extensive set of easy to use, but advanced tools for 3d artists working in 3ds 
max. The focus of the PolyBoost tools is at speeding up and streamlining workflow for the artist. PolyBoost offers a 
wide range of tools for creating various types of subobject selections as well as a set of modeling tools which will make 
many tasks in everyday modeling a lot easier.

ambientLight - Multibay Texture Bundle -$130  This includes our entire range of Texture Packs. All of our 
packs are at a minimum of 1024 pixels square and are hand edited so that they tile perfectly, whatever application you 
use them in!. This pack includes Plant & Trees,  Natural,  Sky,  Architectural,  Roads textures. They do tile seamlessly 
and they, together with the included bump maps, are a great help in making images look more realistic.

Noesis Interactive - Choose Your DVD - $50  Noesis Interactive works to expand knowledge and creativity 
among Video Gamers around the world. From our collection you are allowed to use any DVD of your choice and will 
ship the DVD at your address.

Judges

Allan Mckay - Allan McKay is a Hollywood veteran with over a decade of experience 
working both on feature films and tv commercials for some of the most prestige studios across 
the globe. Allan has been acknowledged for his work on many high profile projects as well as 
being guest speaker on both panels and at conferences around the world including Siggraph, 
Digital Media Festival, Software and Film launches as well as holding masterclasses to not 
only talk about his previous work but also help teach and tutor other up and coming film and 
visual effects students.

http://www.hyperfocaldesign.com
http://www.n-sided.com
http://www.polyboost.com
http://www.ambientlight.co.uk
http://www.noesisinteractive.com


        

Ed Harriss - Ed Harriss is a computer animator that lives in the United States spe-
cifically Raleigh, North Carolina. He work for a company called SAS in their video division. 
(Called SAS Studio Productions) He also run own company, EdHarriss.com, INC. Where he 
do freelance work, create training, books and videos. He is writer of a very popular book “How 
to Get a Job in Computer Animation”.

 
 
 
 
 
 
 
 
 

Harsh Borah - Harsh Borah has been drawing and painting since early childhood and 
professionally working as an artist for about 6 years. He has been working as Lead Character 
artist in computer games and movie industry, contributing to some quality games, game cin-
ematics, Toy figurines and movies visual effects.

His primary focus includes modelling and texturing, but over the time he has gained experi-
ence in lighting/rendering, composition and storytelling through his works. Few of his digital 
tools include, Maya, 3dsMax, Mudbox, ZBrush, Photoshop and more. He is well knows for his 
highly detailed characters and precision in generating realistic looking humans and creatures.

Sponsors

http://www.cgarena.com/ccount/click.php?id=155
http://www.n-sided.com
http://www.polyboost.com
http://www.noesisinteractive.com
http://www.hyperfocaldesign.com
http://www.ambientlight.co.uk
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Making of Black  Bashi - Bazouk
by George Patsouras, USA 
Email: cgaddict@live.com

Web: http://cgaddict.blogspot.com

mailto:cgaddict@live.com
http://cgaddict.blogspot.com


photoshop

Introduction 

In this tutorial, I will go about how I painted a Master Copy of Gerome Jean Leon’s “Black Bashi-Bazouk”. As an artist, 
I feel like I can learn a lot by doing studies of the works of Old Masters, especially in terms of color. It’s important to 
note that when you’re doing Master studies, you shouldn’t just mindlessly copy a painting; Put thought into what you’re 
doing - ask yourself why did this artist choose this color as 
opposed to another, and so forth.

Initial Sketch

Since we are doing a Master Copy, it’s essential we nail 
the proportions of the image we’re trying to recreate. To 
do this, I use a grid to get the proportions as accurate as 
possible. To do this, create a grid over the reference image. 
Then re open the file, fill the canvas with a fairly light gray 
color, and begin sketching box to box. Try to make it as 
accurate as possible, as this step is crucial. Depending on 
how you draw, you should get a fairly clean result. If not, 
lower the opacity of the sketch layer (around 40% should 
be good), create a new layer, and trace over it for a cleaner 
look. Here is my result:

Working in Values

Once that’s done, the next step should be to establish a 
strong value composition. Working in grayscale allows us 
to concentrate strictly on values, without worrying about 
colors. 
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photoshop

In my opinion, a successful painting needs to have a good value composition. You can use any color scheme you want, 
but if the values aren’t working, the painting won’t be successful. The first thing we must do is go to Image > Mode 
> Grayscale. At this point, you should also have your grayscale slider turned on under the ‘colors’ menu (Window > 
Color). Do all your value work using this slider. Do not sample values from the reference, as you won’t learn anything 
from this, and could lead to an unwanted crutch as well.

Start off simple first - use relatively large brushes for the early stages to avoid getting caught up in details. Work in the 
darker values before making your way to the lighter ones. Make sure everything is treated with the same amount of 
detail at the early stages. Have the Size Jitter turned off under ‘Pen Pressure’ during the initial phase to avoid getting 
caught up in details. In other words, don’t overwork the face and keep the rest of the image loose, you’re just going to 
end up struggling at later stages.

For the blending process, I generally 
use a hard edged brush and speckled 
one to blend, with lower opacities for 
smoother transitions (anywhere from 
25%-50% under opacity). You don’t 
need a lot of layers for this stage; One 
for the background and one for the fig-
ure should be fine. Keep things simple. 
When you’re happy with the values you 
set up, you can now turn on Size Jitter 
turned off under ‘Pen Pressure’ and start 
working in the details. Create new lay-
ers and constantly merge them with the 
base layer to keep things under control.

Here is the finished grayscale painting. 
Even in grayscale, the painting looks 
‘complete’. It’s a good idea to have your 
painting as refined as possible before 
adding colors. This will make the color 
process that much easier.
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photoshop

Adding Colors    

When we have a decent painting in grayscale completed, it’s time to think about colors. Since this is a Master Copy, a 
good idea is to step back from our painting for a bit and carefully observe the colors in the original painting. Make sure 
the HSB slider is turned on at this stage, under the colors menu. With the original painting open, select the Eyedrop-
per tool and carefully observe the color transitions throughout the painting. Do this for a couple of minutes and try to 
process how the artist went about colors. 

In this case, the main color scheme is that of a fairly saturated red/orange. The darkest areas are that of a very saturated 
red, and the lighter tones shift more towards an orange/yellow hue. With that in mind, we’re now ready to start add-
ing color to our painting. Since we’ve worked with the grayscale mode, it’s time to change it to the RGB mode. Select 
Image > Mode > RGB. 

Since we spent the time observing the main color scheme, the first thing we do is create a new layer above the base 
layer and set it to ‘color’. Select a fairly red/orange mid tone for the base, since this is the main color theme, and merge 
it. Create another layer, this time for the skin. Observe the shifts in color from the reference photo and try to replicate 
it. The shadows on the face, for instance, has very saturated red tones, while the highlights are that of an orange/yellow 
tone. Do your best to replicate that while choosing your colors from the HSB sliders. Now merge. Repeat this process 
over and over again to build up your colors. 



photoshop

Refinement and Detail

During the color process, don’t be afraid to continue refining the painting; Although you might have a strong base at 
this point, adding to it will only make your painting that much better. Don’t be afraid of the zoom tool, it can be your 
friend; Zoom in very closely to bring out further details, especially those located at the focal point. In this case, I want 
to bring attention to the face, so I make sure that’s the most detailed part of the painting.

Hope you like this making, if you have any critiques and comments then please email me.

George Patsouras
cgaddict@live.com
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after effects

In this after effects tutorial we are trying to create a scanning intrusion Radar Screen which you see in many action 
movies. The effect is quite simple to create but I will try to make it little hard. Just Kidding, I will try to do some extra 
things through expressions which will help in your other projects and not limited to one project.

So before starting I searched in the google for some images and edited them in Photoshop to make fit for this project. 
Please have a look at some images which I collected for this tutorial.

Radar Screen
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after effects

For the water reflection you seen on the screen. I used the image in the right and 
reduce the opacity to 15%. As the screen is not flat so I go into the Liquify and use 
th Bloat Tool.

Step 1:    I created new project in the After Effects 7 Pro and import the PSD source 
file with all the layers. Drag them on the composition and scale it. So, nothing to 
explain here. 

Step 2:    Now I created a new Solid Layer (Ctrl +Y) just the double size of the composition, named Lime Green and 
choose a bright green color.

Step 3:    I applied an Effect >Transition > Radial Wipe on the Solid Layer and choose the following settings. Infact 
in the following settings we need to touch only 3 things i.e Transition complete, Start Angle and Feather to give soft 
edges. If you are thinking that why the solid layer is not going outside the radar screen then the secret is I created a 
circular mask on this solid layer.

Without Feather With Feather



after effects

Step 4:    Enable the 3D Layer switch for the Solid Layer, which gives you the Orientation option. And on every second 
increase the orientation value on Z Axis to give a rotation.

 0s - 0
 1s  - 80
 2s – 160
 3s – 240
 4s – 300
 5s – 359

Step 5:  Now your radar screen scanning will rotate but after 5sec that will stop but now think of two conditions. First, 
you need an animation of 10 sec and not 5 sec. Secondly, you don’t know how long you require and want to make an 
automatic loop. 

a) So, In first condition, select all the key frames of that layer. Press Alt button on your PC keyboard and drag the 
last keyframe till 10 sec, that’s it nothing else to do. You will see all the keyframes adjusted accordingly.

b) In second condition, press Alt and click on the stopwatch near Orientation and enter the following expres-
sion. 

loop_out (type = “cycle”, num_keyframes = 0)

Now your radar scanning animation is looping the whole timeline.

Step 6:   Duplicate the solid layer “Lime Green” and create a new solid layer “Red” for showing intrusion. Keep the size 
of layer very small, create a circular mask and feather it. You can also create a small spot using brush.

Step 7:   Animate the position of the intrusion layer if you like.  Drag this layer in between the two previous Lime 
Green Solid layer.
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after effects

Step 8:    Change the Track Matte to Alpha, so now only when radar screen goes over that area then only intrusion 
will be visible otherwise not. But in some movies I seen a intrusion shown as fade in fade out manner. In that case you 
don’t need an Alpha track matte but need to write a expression in the intrusion layer for Opacity, that will be driven 
by orientation of “Lime Layer”. 

The expression is (thisComp.layer(“Lime Green”).transform.orientation[2] / 3.6 ) * -1 + 100

In above expression [2] is for Z axis because 0 is for X and 1 for Y axis. Then divided by 3.6 because opacity of any 
layer can’t go above 100. But then problem comes the visibility working in an invert way so multiply with -1 so now all 
values is negative and nothing visible. Add 100 or any value to bring same number of opacity. I know it’s quite difficult 
to understand like this but also very difficult to explain, but if you try the above expression then understand in a minute. 
Not a big deal. 

Step 9:     Now your radar screen is ready and you can check the intrusions. If your radar screen is quite old and don’t 
have flat screen then you can apply Effect > Distort >Bulge on an adjustment layer.  Hope you like this small but knowl-
edgeable tutorial. Thanks for reading.

Suzane Smith
suz.smith@hotmail.com

mailto:suz.smith@hotmail.com


Making of Hell Yeah!
by Vaclav Krivanek, Czech Republic 

Email: washek@washek.com 
Web: www.washek.com

mailto:washek@washek.com
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Introduction  

Hello, I want to share with you the small making of my Hell Yeah! 
portrait of the devil. First I’ve start with simple base mesh in 3dsmax 
then I moved my model into zbrush where fun starts.

Tip: Before you’ll export anything to zbrush, don’t forget to reset 
xform (especially when you’re mirroring some objects) you’ll avoid 
many problems. 

Modeling

When I put base mesh in zbrush 
at that time I actually didn‘t know 
how the final version will look, so I 
start playing with shapes, don‘t be 
afraid to do crazy things like move 
ears far from head, make big nose 
or so, you can find some interesting 
shape and then start adding details 
in your model. First idea when I 
start sketching was to make some 
vampirish head but at the end I get 
to devil head :-) 

When you’re sculpting, don’t try to 
subdivide it at 4th level right after 
you put it in zbrush, always try to 
get maximum details even in basic 
model, when you’ll be quite happy 
with that, then just move to anoth-
er level and add more fine details.
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3ds max

I am mostly using just standard brushes like inflate, standard, smooth, pinch and move. I actually didn‘t use any special 
alphas for this sculpture. Great feature is to use lazy mouse (L) for wrinkles and smooth lines and transpose to move, 
scale and rotate your object if it’s needed.

Ok now I’ve finish my sculpture so I need to put it back to max and start the texturing, you can use erotology if its 
needed, but I was ok with second subdivision level and I knew that I won’t use it in some animations so I delete the 
first one and export the second one to max. Then I’ve done some unwrap, great tool for unwrap characters and organic 
things is unfold3d, UVLayout or other similar programs focused just on unwrapping, it’s much easier and faster than 
to do it in max.

When I get my head unwrapped, I’ve import it back to zbrush as a first level of the model.

Tip: Do not change anything on the model when you’re doing unwraping, if you do any change even one edge you 
won’t be able to import it back to zbrush at a first level of your sculpture.Then I generate displace, normal and cavity 
map.
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3ds max

Then I start working with the model in max, just setup some basic 
lighting and composition to more define the final scene, I also use 
some basic rig to play with pose but now I am mostly using trans-
pose in Zbrush to pose my characters. Here is some final setup of 
lights, pose and camera. 

Then I start with some texturing in Photoshop. I played a lot with 
layer blending, just take some concrete photo and blend it nicely 
to the texture or so, face area is made from many pictures of people 
and repainted and blended together. Sometimes is good to take 
one channel from normal map and multiply it into texture, like 
this you can increase some fine nice detail. I didn’t actually play a 
lot with parts which won’t be visible in the final render.

Here are the final diffuse textures:
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I’ve also used some SSS, some specular and reflection masks.

I am using Brazil v2 render system and at that time I had some beta version where included displacement won’t work-
ing well, but brazil can handle many polygons so I’ve used Normal displace modifier in max where I put my displace 
from Zbrush, then just put some turbosmooth on level 3 to get almost same result as some MTD.

I’ve used just 3 lights and very small amount of GI, one main from left with shadows casting and two others not so 
intensive to see some contours on the head without shadows.

Ok now I start to play with shaders. For skin shader I used normal 
Brazil skin shader, you should always try to tweak shader on some 
simple ball and do not waste your render time on your final model. 
When you’re happy with some result on the ball you can put that on 
final model and do your final touches on it. 

Here is one of many render tests.



Ok now is time to do some flames, 
I used Fume FX plug-in for max, 
it’s really easy to use and you get 
amazing results. I`ve select the 
horns as a source of flames. Here is 
some setup in fume FX dialog for 
horns



Then I just click render and let it 
counting for a while, at the end I 
go through all the frames and pick 
the one most interesting for me. 
I also made few smoke renders to 
put on his body.

Here is the final render with flames 
and some smoke.



Then I render few more smoke to put in front of his 
body to combine them in the final picture. As last thing 
I render some fur on the body with default settings just 
tweak the size and length of them to get some nice fine 
fur details in hi-res render. I should use mask for the 
places where I didn’t want to grow fur but I was in big 
rush at the end so I just overlay it and erase parts where 
I don’t required. 

In final compositing in Photoshop, I made few color 
correction, paint some hairs on head, add those smoke 
renders, add even more blood on some places, tweak 

contrast and add simple background. And here is the 
final result as you know it. 

I hope you enjoyed this small making of and now you 
get a better idea of how I did it. Bye

Vaclav Krivanek
http://www.washek.com

washek@washek.com

3ds max
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Introduction 

Hi everyone, in this “making of ” article I am going to show the general process that I went through to create the “Quiet 
Room.”  I used Autodesk Maya to model all of the objects and used Photoshop to do the texturing.  “Quiet Room” is 
one of my recent personal works – I love scary movies, so I think it would be interesting to do an empty, creepy little 
room.

Every time before I start on any project, I collect as much reference as possible from the internet, looking at photo-
graphs, movies and games – it can help to give inspiration for what I want to do.  Below is just a few of the reference 
pictures related to this project.



maya

Modeling

Looking at picture reference is very important for modeling, because you can really see the scale and proportion of each 
object and how they relate to one another.  Many objects in the scene are started from a cube or cylinder, I like to start 
with the simple form and keep adding details and make it the way I want.  After all the modeling is complete then we 
can lay out all the UVs to render an ambient occlusion map, then we can start texturing. 

Here are the grey and the wire frame renders.
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Texturing

I usually like to look at the reference photos and find some interesting patterns and details that make sense for each 
object (like the quilt for the bed cover), and then I begin texturing with these details.  

I am going to talk about how I textured one of the objects in the scene specifically - the rusted chest. Here are all the 
various textures that I used for the chest.

On the next page there is the image showing the process of how I overlay the 
textures together. 



1. I pick two different textures for my base and erase some part of one of the textures, so that the texture will look 
blended with each other.  

2. At this point I find some little details from other photos and put it on the texture.
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3. In this step, I layer the third texture and change the blending mode to “Soft Light” to help to mix the textures to-
gether and get a more of a natural look.

4. On the 4th layer of the texture, I erased part of it and didn’t change any overlay setting.  Leaving the blending mode 
“normal” is nice so that you can see some part of the texture is not mixed in with others – it will help to show the thick-
ness of the texture.  

5. Multiple more textures are layered on top of everything for specific detail while erasing little part of it.  This is im-
portant to break up the tone of all the textures and creates the different values in different areas.

6. In the final stage, just multiply AO map on top of all textures to help set the object down in the scene.   

Here is the dresser texture page.  It is basically using the same method as how I textured the chest.  





Specular Map

Specular Map

Specular MapBump Map

Here are some texture pages and normal 
maps of other objects in the scene.



gallery
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